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The enclosed 3-inch mini CD is compatible with most computer CD-ROM
drives. Place the disk in the indent in the center of the CD tray. If your CD
drive is not compatible with mini CDs, use another computer to copy the

mini CD to a regular CD, DVD or network folder.
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This Dostek End-User License Agreement is a legal agreement
between you (an individual or legal entity) and Memex Inc. for the
Software Product know as "Dostek DNC". The Software Product
includes the computer software and data files, and the printed and
on-line documentation. By installing or using the Software Product,
you agree to the terms of this agreement. If you do not agree to the
terms of this agreement, you may return the Software Product for a
refund within 30 days of purchase.

COPYRIGHT

All title and copyrights in and to all components of this Software
Product (and all copies thereof) and the accompanying printed
materials are owned by Memex Inc. This Software Product is
protected by United States, Canadian and international copyright laws
and treaties. You may make an unlimited number of copies of the
software, provided that such copies are used only for internal
purposes in compliance with the terms of this License Agreement and
provided that such copies are not republished or distributed to any
third party. You may make an unlimited number of copies of the
printed or on-line documentation, provided that such copies are used
only for internal purposes and are not republished or distributed to any
third party. 

SOFTWARE PRODUCT LICENSE

This Software Product is licensed (not sold). This License Agreement
grants you the following rights:

1. Use of Software Product. Memex Inc. grants you a non-exclusive
license to install copies of the Software on any number of computers
provided that the Software may be used on only one computer at any
time for each license purchased. A license for the Software may not
be shared or used concurrently on different computers.

2. Transfer. You may permanently transfer all of your rights under this
License Agreement according to the following provisions: (a) you
transfer the entire Software Product, including all component parts,
media, printed materials, any upgrades, and this License Agreement;
(b) the recipient agrees to the terms of this License Agreement;  (c)
you do not retain any copies of the Software Product or any
component parts, including any upgrades received for the Software
Product; (d) the Software Product is not labeled "Not for Resale" or
"Demonstration Copy".

3. Demonstration Copies. You may not resell or otherwise transfer the
Software Product if it is labeled "Not for Resale" or "Demonstration
Copy".

4. Components. The Software Product is licensed as a single product,
and its component parts may not be separated for transfer or for use
on more than one computer.

5. Rental or Lease. You may not rent, lease, or lend the Software
Product.

6. Reverse Engineering. You may not reverse engineer, de-compile or
disassemble the Software Product.

7. Termination. Without prejudice to any other rights, Memex Inc. may
terminate this License Agreement if (a) you fail to comply with the
terms and conditions of this License Agreement, or (b) you fail to
comply with the terms of the Sales Invoice or Agreement of Sale for
the Software Product as issued by Memex Inc. or by an authorized
Memex Inc. re-seller. On termination of this License Agreement by
either party, you must destroy all copies of the Software Product and
all of its component parts in your possession.  

8. Temporary License. If you are granted a Temporary License that is
valid only until a specified Termination Date, this License Agreement
automatically expires on the specified Termination Date. On
termination of the Temporary License, you must comply with the
conditions of Termination (paragraph 6), or obtain a License Renewal
from Dostek.

9. Upgrades. To qualify for a specially-priced Software Product
Upgrade, you must be properly licensed. Use of the upgraded
Software Product is subject to the terms of this License Agreement
and the License Agreement (if any) provided with the upgrade.

10. This License Agreement is governed by the laws of the Province
of Ontario, Canada.

LIMITED WARRANTY

Dostek warrants that the Software Product will perform substantially in
accordance with the accompanying documentation for a period of
ninety (90) days from the date of receipt. Memex Inc. will make every
reasonable effort to correct any problem issues. This Limited
Warranty is void if failure of the Software Product results from abuse,
improper application or accident.

LIMITATION OF LIABILITY

Reasonable care has been taken in the design and preparation of the
Software Product. To the maximum extent permitted by law, in no
event shall Memex Inc. be liable for any indirect, special, incidental or
consequential damages whatsoever (including, without limitation,
damages for loss of business information, business interruption,
business profits, or any other loss) in connection with or resulting from
the use or the inability to use the Software Product. Memex Inc.'s
entire liability under any provision of this License Agreement shall be
limited to the amount actually paid by you for the Software Product.

NO OTHER WARRANTIES

Memex Inc. disclaims all other warranties and conditions, either
express or implied, including, but not limited to, implied warranties of
merchantability and fitness for a particular purpose.

Please contact Memex Inc. Incorporated if you have any questions
concerning this License Agreement.

Memex Inc.
www.memex.ca
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© Copyright 2015 Memex Inc. All rights reserved.
No part of this Document may be reproduced in any form or by any means without prior
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Dostek DNC V15 - User Guide
This guide explains how to install, configure and use Dostek DNC software Version 15.

Dostek DNC is a suite of applications that work together to let you manage and edit
files, and transfer data between your computer and CNC machine tools. 

With Dostek DNC, you can: 

• Transfer programs and data between a Windows computer and CNC machine tools.

• Upload, download, and drip feed with data transfer rates up to 38,400 baud. 

• Edit files, including: copy and paste, search and replace, reformat and renumber. 

• Manage files, including: view, search, copy, rename, filter, and delete. 

• Configure communication parameters and protocols to work with virtually any CNC
machine equipped with an RS-232C serial port. 

• Configure security and logging to control access and track activity. 

• Work with standard Windows PCs (Windows XP through Windows 10). 

• Work with multi-port serial cards and hubs (Ethernet and USB, wired and
wireless).

Additional Resources

For information about additional resources, including help documents, application
notes and technical support, see Section 9.5, "Getting Help."
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1 Installing Dostek DNC

This section explains:

Installing Dostek DNC software (Section 1.1)
Installing Dostek DNC software license key (Section 1.2)
Understanding your Dostek DNC software license (Section 1.3)

To ensure success, prepare your files, COM ports and cables before you begin
installing Dostek DNC:

Upgrading or moving Dostek DNC?

If you are updating, replacing or moving existing Dostek DNC software, make a
new backup copy of your existing Dostek DNC configuration files. You can use your
existing files with a new computer or software version. For detailed instructions,
see Section 4.4, "Backing Up Configuration Data."

Organize your CNC part program files.

Determine the location of your CNC part program files. Dostek DNC can access files
on the computer's hard drive, removable media, or a shared network folder. Dostek
DNC Setup Wizard lets you choose a folder. You can add more folders later. If you
don't have an existing folder, the Wizard suggests one for you.

Itemize your CNC machine tools.

Make a list of control models you will use with Dostek DNC. This is the model of the
control, not the machine. Dostek DNC Setup Wizard asks you to pick from a list of
more than 100 sample configurations. You can choose more later. 

Install and itemize your Windows COM ports.

Your computer needs at least one RS-232C serial COM port. If your computer does
not have a built-in COM port, you must install one. If you plan to use remote DNC,
you need a separate COM port for each CNC machine.

Dostek DNC works with any Windows COM port, including: built-in, plug-in,
USB/serial or Ethernet/serial (wired or wireless). For information about
recommended COM port products, visit www.dostek.com/order and click "Dostek
DNC Application Guide and Price List."

If you are moving COM ports from a previous computer, visit the manufacturer's
Web site  to download the latest device driver software. 

If you plan to move Dostek DNC configuration files from the previous computer,
also make a list of each adapter and each port, the corresponding Windows COM
port number, and the machine it is connected to. Windows may not assign the
same COM port numbers on the new computer; you will need this information to
update your configuration files.

Prepare your cables.

If you do not have existing cables connecting the CNC machines to your Windows
COM ports, you can build or purchase cables. To build cables, see the "RS-232C
Cables" help topic in Dostek DNC's "Communication Testing and Troubleshooting"
help file. To purchase cables, contact Dostek. Many CNC models require a
"cross-linked null modem" cable, which is not commonly available.

Page 2 Dostek DNC V15 - User Guide
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1.1 Installing Software

To install Dostek DNC:

1. Open Dostek DNC Setup. 

The method for opening Setup depends on whether you are installing using a
software CD or a software download file:

Software CD

If you purchased the optional software CD and printed User Guide from
Dostek, insert the software CD in your computer's CD drive. Setup opens
automatically. If Setup fails to open automatically, use  Windows Explorer to
manually open Setup.exe. The software CD is packaged in a plastic sleeve
inside the front cover of the printed User Guide.

Software Download File

Open the software download file. The download file is named with the prefix
"DDW" followed by a five-digit software version. For example, the file for
version 15.10A is "DDW1510A.exe".

For more information about downloading Dostek DNC software, see
"Appendix A - Downloading Dostek DNC."     
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2. Click Next to continue, and then follow the on-screen instructions to complete
software installation. When finished, Setup automatically opens Dostek DNC
First-Time Setup wizard.

Dostek DNC First-Time Setup Wizard guides you through:

¤ Installing your software license key. 
¤ Viewing the Getting Started Guide. 
¤ Setting up file locations and program shortcuts. 
¤ Selecting from the supplied sample CNC configurations. 
¤ Learning about backing up your data. 

3. When the First-Time Setup wizard prompts you to "Choose setup mode,", choose
one of the following options:

¤ If you are installing Dostek DNC for the first time, select New Installation
and continue following the wizard's on-screen instructions.

¤ If you are updating an existing, working, copy of the software, select Keep
existing configuration.

¤ If you are replacing a previous installation of Dostek DNC (to use a new
computer, or to use the same computer after removing Dostek DNC), select
Load previously-saved configuration.

4. Follow the on-screen instructions to complete the Wizard. When the Wizard is
finished, it automatically opens Dostek DNC Navigator.

Page 4 Dostek DNC V15 - User Guide
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1.2 Installing Your Software License Key

If you install Dostek DNC using the optional software CD, your software license key file
is included on the disk and is installed automatically.

If you downloaded Dostek DNC, you received your software license key by email. You
can install it automatically (recommended), or you can manually type in your license
key data.

Dostek DNC must be installed on your computer before you install your license key.

1.2.1 Install Automatically (Recommended)

To automatically install your Dostek DNC software license key:

1. Open the license key file attached to the email message you received from
Dostek. Dostek DNC License Registration Wizard opens automatically, and
displays your license key data.

2. Confirm that your license details are correct, and then click Finish. If your name,
address or license details are incorrect, contact Dostek to obtain a new license
key.  

Note:

› To automatically install your software license key on a computer that does not
have access to your email, save the license key file to a portable media device
(USB memory) or a shared network folder.

Dostek DNC V15 - User Guide Page 5
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1.2.2 Install Manually

If you are unable to install your license key file automatically, you can install it
manually:

1. On the Windows Start menu, point to All programs. The Windows programs
menu opens. 

2. Point to Dostek DNC, and then click Install new license key. Dostek DNC
License Registration Wizard window opens. 

3. Type your license key data provided in the email message you received from
Dostek. You must type the data EXACTLY AS SHOWN, including punctuation
and upper/lower case letters. 

Notes:

› Your license key text includes 7 items, and looks something like this:
(1) Company name
(2) Street address
(3) City, State
(4) 20123867 (5) EPZLFWLL (6) 41533
(7) F5D0-D205-902B-30C2-4493

› Items (4) and (6) are all numbers. 

› Item (5) is all uppercase letters. 

› Item (7) contains numbers 0-9 and letters A-F only.

› Omit the printed item number when typing license data. For example, type
"Company name", not "(1) Company name". 

4. Click Next. The Wizard displays your license key data.

5. Confirm that your license details are correct, and then click Finish. If your name,
address or license details are incorrect, contact Dostek to obtain a new license
key. 
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1.3 Understanding Your Dostek DNC Software License

To view your current Dostek DNC software license status:

• Click About in Dostek DNC's Help menu. The "About" window opens, and displays
the software edition and number of seats and COM ports licensed.

To view the Dostek DNC software license agreement, choose either of the following
methods:

• Click License in the "About" window.

• Open Dostek DNC Navigator, and then click License in the "Introduction" tab.

Your Dostek DNC software license key includes the following information:

• Company name and address. Your company name is displayed in the title bar of
Dostek DNC windows.

• Number of computers licensed. Purchase an additional license for each additional
computer.

• Support expiry date. Free software updates and limited support are provided until
your support expires. Thereafter, you can purchase support, one-time software
update, or an annual support subscription.

• License type:
¤ Standard. License never expires (see item 1 below).
¤ Trial. Expires after the trial period (usually 30 days).
¤ Demo. Dealer demonstration license. Must be renewed annually.

The terms and conditions of your software license include:

1. Your standard Dostek DNC software license key never expires. You can use the
software version you purchased forever. However:

¤ Software updates are free for one year from the date of purchase. Thereafter,
you must either purchase an update or annual support subscription to obtain a
newer software version. 

¤ Your license does not entitle you to free replacement. You are
responsible for making backup copies of your Dostek DNC software CD
and software download files. Only the current software version is
available from Dostek. If you lose your Dostek DNC software, you must
purchase a software update to obtain the current version. For more
information, see Section 8, "Protecting your Investment."

2. You may use Dostek DNC software on the number of computers specified by your
software license key. To use Dostek DNC on additional computers, contact Dostek
to purchase additional software licenses. 

3. Purchasing an additional license (for an additional computer) does not include a
software update.   

4. You are permitted to install your Dostek DNC software on one spare computer for
backup or testing purposes only (for example: to permit you to quickly replace
your primary computer if it stops working). 
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2 Dostek DNC Components

Dostek DNC includes the software components listed in the table and described briefly
on the following pages:

Dostek DNC Component Version Information DComponentVersionInfo 

Dostek DNC File Checker DFileChk 

Dostek DNC View Tape DViewTape 

Dostek DNC Fix Files DFixFiles 

Dostek DNC File Rename DRename 

Dostek DNC File Filter DFilter 

Dostek DNC Job Manager DJobMgr 

Dostek DNC Basic User Interface DBasicUI 

Dostek DNC Event Log Viewer Wizard DLogView 

Dostek DNC Shortcut Manager DLinkMgr 

Dostek DNC Setup/License Wizard DWizard 

Dostek DNC Com Test Terminal DTerminal 

Dostek Touch DNCDTouchDNC

Dostek DNC Configuration DConfig 

Dostek DNC Remote Server DRemote / DMComm

Dostek DNC Communication DDNC 

Dostek DNC Editor DEditor

Dostek DNC File Manager DFileMgr

Dostek DNC Navigator DDNav

Dostek DNC Software Components
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Navigator (DDNav)

Dostek DNC Navigator provides links to Dostek DNC applications, documents, help
files, and more. Links are categorized by tabs so you can quickly find what you need. 

To use navigator:

1. Select a category by clicking a tab.

2. Click a link to open an application, document, help topic or Web page.

To guide new users, Navigator starts automatically each time Windows starts. You can
clear "Start Dostek DNC Navigator automatically..." when you become familiar with
the software.
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File Manager (DFileMgr)

Dostek DNC File Manager has the familiar look and feel of classic Windows Explorer,
but is easier to use and provides many enhancements and security features. With File
Manager, you can:

• Organize your files.

• Browse folders and select files. 

• View, print, copy, rename and delete files. 

• Restrict access to specific folders and file types. You can include folders on the
computer's hard drive, a network drive or removable media.

• Customize viewing preferences and command buttons.

The File Manager window provides the following controls:

• Menu bar immediately below the window title bar.

• Toolbar with icons for frequently-used commands below the menu.

• Folder window, file window, and file preview window. You can drag the divider
between the folder and file window to change the window sizes.

• Status panel at the bottom to display file information. 

• Customizable shortcut buttons.
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Communication (DDNC)

Dostek DNC Communication transfers files between the computer and CNC machine
tools. With Dostek DNC Communication, you can: 

• Load, save and drip feed with transfer rates up to 38,400 baud. 

• Stop, start, repeat, or restart anywhere in the file when drip-feeding. 

• Automatically store received programs according to the program name or part
number. 

• Automatically select a machine configuration according to the current folder. 

• Display customized on-screen operator instructions.
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Dostek DNC Remote Server (DRemote, DMComm)

Dostek DNC Remove Server lets you use remote call-up methods to transfer files to
multiple CNC machines. With Dostek DNC Remote Server, you can: 

• Simultaneously upload, download and drip feed up to 64 CNC machines
(depending on software license).

• Remotely call up programs directly from the CNC; there is no need to walk to the
computer. 

• Remotely print files and search directories. 

Dostek DNC Remote Server consists of two components: 

• DRemote (user interface). DRemote provides a split window showing a list of
machines in the top window and event log messages in the bottom window. 

• DMComm (communication server). Starts automatically with DRemote, then runs
in the background to handle CNC communication. 
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Editor (DEditor)

Dostek DNC includes a multiple-document editor for CNC part programs and text files.
With Dostek DNC Editor, you can: 

• Open multiple files of virtually unlimited size. 

• Copy text between files. 

• Search and replace text. 

• Undo and redo changes. 

• Reformat CNC part programs (expand, compress, resequence and reformat
numbers). 
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Configuration (DConfig)

Dostek DNC Configuration lets you quickly configure software options and communica-
tion parameters. With Dostek DNC configuration, you can: 

• Configure general settings including file locations, security settings and global
options. 

• Configure CNC communication settings including baud rate, parity and flow control
options. 

• Choose from sample configurations for more than 100 CNC models. 

• Create a separate configuration for each CNC. 

• View a detailed help page, with practical examples, for each configuration
category. 

• Record notes for each configuration. 

• Use the New Device Setup Wizard to guide you through CNC communication
configuration options.

• Use the Configuration Manager Wizard to quickly back up and restore configuration
information.
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Dostek Touch DNC (DTouchDNC)

Dostek Touch DNC is a simplified user interface for touch-screen users.

With DTouchDNC, you can:

• Work with touch-screen computers and tablets.

• Browse and select a subfolder.

• Select a file by touch, or by typing a file name.

• Preview content of the selected file.

• Send or receive a file, opening the Dostek DNC Communication window.

DTouchDNC provides:

• A full on-screen touch keyboard you can hide when not needed.

• Large fonts and controls for convenient touch operation. 

• A choice of three window sizes to accommodate a range of touch-screen and tablet
devices.
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Communication Test Terminal (DTerminal)

Dostek Com Test Terminal (DTerminal) is a communication troubleshooting tool. With
DTerminal, you can:

• Easily experiment with communication settings such as baud rate and parity. 

• Display received data, including control characters that are not normally visible. 

• Send data and control codes by typing on the keyboard or by sending data from a
text file. 

• Use ASCII, ISO, EIA-244 and hexadecimal data formats. 

• Control and display COM port modem control signals (DTR, DSR, CTS, RTS and
CD). 

• Capture received data into a log file to examine, print or email. 

• Test cables, COM ports and CNC RS-232 serial ports using a variety of methods
including loopback tests and continuous test patterns. 

• Analyze communication protocols. 

• Enumerate available COM ports. 

• Automatically detect CNC baud rate, parity and data bit settings.

• Control and test the Dostek Model 440A Behind-the-Tape Reader (BTR) interface.
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More Dostek DNC Components

To open an infrequently-used Dostek DNC software component that is not linked to
the Windows Start menu:

1. Open Dostek DNC Navigator.

2. Select the Start tab, and then click Application Launcher.

Additional components include:

DFilter - Dostek DNC File Filter 

DFilter reformats CNC programs in the following ways: 

• Remove lines, comments, block numbers, spaces, and unprintable characters. 
• Search and replace text. 
• Convert end of line codes to Windows standard format. 
• Convert text to upper case characters. 

Use this utility program to clean up and convert files or to replace text strings in
several files. Refer to Application Note AN05 - Using DFilter to Modify Files
(available for download at the Dostek web site). You can use DFilter to modify all
files in a folder, including sub-folders.

DRename - Dostek DNC File Rename 

DRename renames groups of CNC programs or changes the file type (extension).
Refer to Application Note AN06 - Using DRename to Rename Files. 

DFixFiles - Dostek DNC Fix Files 

DFixFiles fixes specific problems with the formatting of certain types of CNC
programs. Refer to Dostek application note AN29 - Using DFixFiles. 

ViewTape - Dostek DNC View Tape 

ViewTape displays a data file in a format resembling a punched tape. ViewTape
displays data in decimal, hexadecimal, binary, punched tape and ASCII formats.
Use ViewTape to compare a data file with an actual punched tape when copying or
transcribing tapes to disk files. 

DFileChk - Dostek DNC File Checker 

DFileChk scans specified files to identify those incompatible with Windows. Files
transferred from non-Windows systems or created by some applications may not be
compatible with Windows. Incompatible files can cause problems when editing or
sending to the CNC. 

DComponentVersionInfo - Dostek DNC Component Version Information 

DComponentVersionInfo displays the current version of each software component
used by Dostek DNC. Use when directed by Dostek technical support. 
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3 Getting Started with Dostek DNC

This section explains how to get started using Dostek DNC.

3.1 Opening Dostek DNC Windows

You can open Dostek DNC windows using several methods, including:

• In the Windows Start, All programs menu, point to Dostek DNC and click an
item in the menu.

• Click a shortcut icon you create on the Windows Desktop, Windows Start Menu or
Windows Quick Launch Bar. To create shortcuts, you can drag and drop shortcuts
from the All programs, Dostek DNC menu, or you can click Shortcut Manager
in Dostek DNC Configuration's Tools menu.

• Click a link in the "Start" or "Configure" tab in Dostek DNC Navigator.

• Click a shortcut in another Dostek DNC window's menu or toolbar.

3.1.1 About Multi-Tasking

Dostek DNC's modular design means you can simultaneously open multiple windows.
For example, you can have the File Manager, Editor and Communication windows all
open at the same time.

Commands in each window can open other windows. For example, when you click
Send or Configure in Dostek DNC File Manager, the Dostek DNC Communication or
Dostek DNC Configuration window opens. 

To switch between open windows, click an icon in the Windows taskbar or press
Alt+Tab.

3.1.2 About Single or Multiple Instances

You can only open one copy (instance) of most Dostek DNC components. If you try to
open a new copy of a window that is already open, the existing window automatically
pops to the top.

You can open multiple instances of the Communication window, but each instance
must use a different communication port. This way, you can drip feed to more than
one CNC at the same time.  
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3.2 Getting Started

This section provides an overview of the recommended steps for getting started with
Dostek DNC. 

To get started with Dostek DNC:

1. Organize your files and prepare your COM ports and cables. For details, review
the recommendations on page 2 ("Installing Dostek DNC").

2. Open Dostek DNC File Manager (DFileMgr). If you did not specify a root folder in
the First-Time Setup Wizard, click Root folders in the Configure menu to select
one or more folders containing your CNC part program files.

3. Click Communication (CNC) settings in File Manager's Configure menu.
Dostek DNC Configuration (DConfig) opens. 

a) If you did not select a sample CNC configuration in the First-Time Setup
Wizard, click Import sample configuration in DConfig's File menu, and
select a sample configuration. Samples are provided for more than 100 CNC
models. For more information about using sample configurations, see Section
4.2, "Using Sample CNC Configurations."

b) Select the "Notes" tab, and read carefully. Samples may include
recommended CNC parameter settings, special cable requirements, and
operational notes.

c) Select the "Port Settings" tab, and configure the Computer COM port to select
the port you plan to use, and configure the baud rate to match the CNC baud
rate.

For more information, see Section 4.1, "Configuring CNC Communication
Settings."

Tip:

› If you organize part program files for each CNC machine into separate
folders, and name your folders and CNC configurations with the same names,
Dostek DNC can automatically select the correct CNC configuration when you
click Send or Receive. For details, see "Communication Options" in Section
4.2.3, "General Configuration Highlights."

4. Test communication with each CNC:

a) Send a file from the CNC to the computer first (click Receive in DFileMgr).
This is the easiest way to confirm that you are using the correct cable and
COM port, and that the CNC baud rate matches the Dostek DNC baud rate.

b) Ensure received files are named according to your preference. 

c) Next, send a file from the computer to the CNC.

If you encounter a problem receiving or sending a file:

a) Point to Help topics in File Manager's Help menu, and then click
Communication testing. 

b) Click Problem Index in the "Contents" tab, and then find the help topic that
best describes the symptoms. If you are unable to find a solution, contact
Dostek.

5. To use Dostek DNC Remote Server (DRemote), it is important to first complete
the previous steps. When you open DRemote for the first time, a help window
opens. Take a few minutes to read each help topic.
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3.3 Using Classic or Remote DNC

You can use Dostek DNC for "classic" or "remote" DNC communication.

With classic DNC, you walk back and forth between the computer and CNC to transfer
files. 

With remote DNC, you can upload, download and drip-feed without leaving the CNC.
There is no need to walk to the computer. You send commands to the computer using
the CNC's control panel. 

For classic communication, open Dostek DNC File Manager:

• On the Windows All programs menu, point to Dostek DNC, and then click
Dostek DNC File Manager.

For remote communication, open Dostek DNC Remote Server:

• On the Windows All programs menu, point to Dostek DNC, and then click
Dostek DNC Remote Server.

Notes:

› Before you use classic DNC, you must first create one or more CNC configurations.

› Before you use remote DNC, create a separate configuration for each CNC, and
test communication using classic DNC.

› To open Dostek DNC File Manager or Remote Server automatically each time the
computer starts, copy the shortcut from the Windows All Programs menu to the
Windows "All Programs\Startup" folder.
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4 Configuring Dostek DNC

This section explains how to configure Dostek DNC settings and preferences, and how
to save time by using sample CNC configurations.

Dostek DNC provides three types of configuration settings:

• CNC communication settings (baud rate, flow control, etc.)

• General settings (security, file types, documents, event logging, etc.)

• Component-specific settings (fonts, view options, etc.)

4.1 Configuring CNC Communication Settings

To use Dostek DNC Configuration (DConfig) to configure CNC communication settings:

• Click Configure devices (CNCs) in File Manager's Configure menu. Dostek DNC
Configuration (DConfig) window.

Settings are organized by "tabs" to make it easy to find the setting you need. Detailed
help is provided for each tab. To learn about settings for a particular tab, click Help in
the Help menu, or click the Help icon in the toolbar.

When configuring CNC settings, DConfig makes it easy to navigate between multiple
configurations without the need to close and reopen windows. You can:

• Select a configuration in the drop-down list.

• Click the left or right arrow next to the drop-down list.

• Press the F2 or F3 key on your keyboard to select the previous or next
configuration.

This feature lets you select a tab and then quickly scan the same settings in your
other CNC configurations.

Notes:

› To change between general settings and CNC settings, click the "Tab" icon at the
far left of the toolbar.

› You can also open Dostek DNC Configuration from the Configuration tab in Dostek
DNC Navigator, from the Windows Start menu, or from the Tools menu in many
Dostek DNC windows.   
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4.1.1 Using Sample CNC Configurations 

Sample device configuration files are provided for more than 100 CNC models. To use
a sample configuration:

1. Click Import sample configuration in DConfig's File menu. The Sample Import
Wizard opens.

2. Follow the on-screen instructions to import the configuration.

Note:

› Each sample configuration includes a "Notes" tab. Carefully read the information
provided in this tab. Information can include recommended CNC parameter
settings, operational notes and special cable wiring. Using sample configurations
dramatically reduces the time it takes to get started.

4.1.2 CNC Configuration Highlights

CNC configuration settings are organized in several tabs. This section describes a few
commonly-used settings. For detailed information and examples, select a tab and then
click Help in DConfig's Help menu.

Device Tab

You can:

• Specify an IP address. If you are using Ethernet/serial adapters with static IP
addresses, include the IP address for each configuration's COM port on the
"Device" tab. When you include an IP address, DRemote and DTerminal include
convenient commands to ping the IP address or open the adapter's Web console.

• Select an icon. Icons are provided for a variety of machine types (lathe, horizontal
and vertical machining centres, etc.).

• Enter a useful description, such as the control mode ("Fanuc 18Ti"). Or, if you use
multiple-port serial hubs, you could include a comment identifying which hub and
port ("H3P4") the configuration uses. Dostek DNC displays the comment in certain
windows, and includes it in configuration lists. 

• Click List all configurations in DConfig's File menu to view a sorted list of all
CNC configurations. To sort the list, click a column heading. You can copy the list
to a spreadsheet or text file using the Windows Clipboard.

Port Settings Tab

You can:

• Configure Computer COM port to match the port the CNC is connected to. Click
List to view a list of available COM ports.

• Configure the baud rate to match the CNC baud rate setting.

Note:

› When using a sample CNC configuration, do not modify the remaining settings. 

› ISO, Even, 7, 2 and Xon/Xoff are best for most modern CNCs.   
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Transmit Options Tab

You can:

• Configure Transmit trigger to "Xon" to automatically start sending when you
press Read or Input on the CNC. Using a trigger lets you prepare the computer
first, then walk to the CNC machine.  

• Select Skip header to or Skip trailer from to skip over comments at the start or
end of your part program files.

With "classic" DNC, you can also:

• Configure Transmit trigger to "None" to send immediately, or to "Manual" to
send when you click Start now.

• Configure Repeat mode to automatically re-send the program from the beginning
when the end is reached. Choose this option to drip-feed the same program
multiple times.

• Select Pause between files to require the operator to press Read or Input to
load each file when loading multiple files.

• Enter a message (instructions) to appear on the screen when sending a file to the
CNC machine.  

Receive Options Tab

You can:

• Configure automatic file naming for received files. Dostek DNC can automatically
name files according to the program number, or according to a comment included
in the first line of the file (part number, description, etc.).

• Specify a file extension (type) for received files. When specified, Dostek DNC
automatically applies the extension to all received files. When using remote DNC,
this also becomes the default extension when searching for requested files.

• Specify a prefix or suffix to apply to all received files. Use this feature to prevent
overwriting original files or to distinguish received files so they are easy to find.
For example:

¤ Specify a prefix of "!" so all received files appear at the start of the file list in
File Manager or Windows Explorer.

¤ Specify a suffix so received files and original files appear together in File
Manager or Windows Explorer.

¤ Specify a machine mnemonic to identify the machine from which a file was
received. For example, specifying "VMC75-" names received files as
"VMC75-1234".

With "classic" DNC, you can also:

• Enter a message (instructions) to appear on the screen when receiving a file from
the CNC machine.

Remote Commands Tab

If you use Dostek DNC remote server (DRemote), you can customize the command
format to suit your preferences. View the help topic for detailed examples.

Notes Tab

Dostek DNC sample configurations can include recommended CNC parameter settings,
operational notes and cable wiring in the Notes tab.

You can also type your own notes.  
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4.2 Configuring General Settings

To use Dostek DNC Configuration (DConfig) to change general settings:

• Click Configure Dostek DNC in File Manager's Configure menu.

Settings are organized by "tabs" to make it easy to find the setting you need. Detailed
help is provided for each tab. To learn about settings for a particular tab, click Help in
the Help menu, or click the Help icon in the toolbar.

Notes:

› To change between general settings and CNC settings, click the "Tab" icon at the
far left of the toolbar.

› You can also open Dostek DNC Configuration from the Configuration tab in Dostek
DNC Navigator, from the Windows Start menu, or from the Tools menu in many
Dostek DNC windows.   

4.2.1 General Configuration Highlights

Dostek DNC configuration settings are organized in several tabs. This section describes
a few commonly-used settings on each tab. For a detailed information and examples,
select a tab and then click Help in DConfig's Help menu.

Folders Tab

You can:

• Specify one or more root folders to restrict Dostek DNC access to specified folders.
(See Section 4.3, "Configuring Root Folders)

• When you specify a receive folder, Dostek "classic" DNC can receive files to the
specified folder only. This prevents users from overwriting files in other folders
when receiving data from the CNC machines.

File Types Tab

You can optionally categorize file types to control how File Manager handles files:

• NC files can be edited or sent to the CNC.

• Document files (as well as Windows LNK shortcut files) are opened using the
Windows registered default program. For example, PDF files are opened in Acrobat
reader, and DWG files are usually opened in AutoCAD or a CAD file viewer.

• Binary files may be sent to the CNC, but may not edited.

• Restricted files can not be used or modified.

Communication Options Tab

You can:

• Select "Match CNC Configuration To Folder" to automatically match the device
configuration to the folder name. This feature can save time and prevent errors.

• Specify default receive file naming options. The CNC configuration overrides these
settings. The default options apply only when the corresponding setting is blank in
the CNC configuration.

• Set a high communication priority when drip-feeding, to ensure other Windows
tasks do not interfere.    
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Security Tab

You can disable (hide) all Dostek DNC commands that modify files or folders. For more
information about Dostek DNC security features, see Appendix D, "Understanding
Security."

Documents Tab

You can configure Dostek DNC to search for documents related to a CNC part program
file. When click View related documents in File Manager's File menu, File Manager
searches for the types of documents you specify that match the name of the selected
file. With this feature, you can quickly find related drawings, setup sheets or PDF
documents.

Event Log Tab

You can configure Dostek DNC to log specific events to a standard database file.

Editor Tab

You can configure Dostek DNC to open an editor of your choice when Edit is clicked
(replacing Dostek DNC Editor).

4.3 Configuring Root Folders

You can configure Dostek DNC to access one or more specific local or network folders,
or your entire computer and network.

To configure root folders:

1. Click Root folders in Dostek DNC File Manager's Configure menu, or select the
"Folders" tab in Dostek DNC Configuration (General), and click Change. The
"Manage Root Folders" window opens, showing a list of all "root" folders currently
configured.

2. Do one of the following:

¤ Click Computer to provide access to the root folder of all local and network
drives. Any other folders in the list are removed.

¤ Click Change to replace a folder in the list with a different folder. 

¤ Click Add to add another folder to the list.

¤ Click Remove to remove a folder from the list.

¤ To rearrange the order of root folders, select a folder and then click the Up or
Down "Move" button.            

Dostek DNC V15 - User Guide Page 25

 www.memex.ca    



4.4 Configuring File Manager, Editor and Remote Server Options

To change File Manager options and preferences, click Options in the Configure
menu, and then do one of the following:

• Select the View Preferences tab to change display preferences.

• Select the File Type Filters tab to change the types of files that are displayed.

• Select the QuickButtons tab to add or change QuickButtons.

• Select the Utilities tab to add or change commands in the Utilities menu.

To change Editor options and preferences:

• Click Preferences in the File menu.

• Click Page Setup in Editor's File menu to change the page layout and font size
used for printing.

To change Remote Server options:

• Click Options, Special options or Event logging in DRemote's Configure menu.

4.5 Backing Up Configuration Data

To back up your configuration data, you can either:

• Click Express Backup in DConifig's Tools menu. Express Backup copies Dostek
DNC's configuration files to a folder you specify.

• Click Configuration Manager in DConfig's Tools menu. Configuration Manager
lets you manage multiple sets of configuration files, such as when Dostek DNC is
installed on multiple computers.

Important:

› Always make new backup copies of your configuration data each time you make a
change to any setting.
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5 Using "Classic" DNC Communication

With "classic" DNC, you walk back and forth between the computer and CNC to
transfer files. You can initiate a transfer at the computer and complete it at the CNC.
Data scrolls in the Communication window during the transfer.

You can:

• Send a file from the computer, and load it into the CNC's memory.
• Drip-feed a program directly from the computer.
• Receive a file from the CNC, and save it to a computer file.

Dostek DNC is used the same way whether loading a file into the CNC's memory or
drip-feeding the program directly. Only the CNC is used differently for drip-feeding.
For example, with most Fanuc CNCs you select Program Edit mode and execute a
Read or Input command to load a program into the CNC's memory, or you select Tape
mode and press Cycle Start to drip-feed a program directly from the computer.

5.1 Sending a File to the CNC

Sending a file to the CNC (or drip-feeding a large file) is a simple 3-step process with
Dostek DNC:

STEP 1 - Select a File

Open Dostek DNC File Manager. Folders are listed in the left window, and files in
the right window. Select the file you wish to send or drip-feed to the CNC.

You can:

• Click Search or Go to file in File Manager's Search menu to find a file by typing
a name.

• Select multiple files to send to the CNC together.

• Click [+] or [-] in File Manager's folder window to expand or collapse a folder tree.

• Click an icon in the toolbar or the View menu to choose from one of four file
viewing formats. 

For more information about selecting files, see Section 7.1, "Selecting Files and
Folders."          
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STEP 2 - Click "Send"

Click Send. File Manager opens the Dostek DNC Communication window (DDNC) to
send the file to the CNC. 

If you created more than one CNC configuration file, DDNC "pops up" the "Select
CNC configuration" window to let you pick a configuration.

The transfer continues according to your Dostek DNC configuration:

¤ In most cases, DDNC pauses and indicates "Waiting for trigger" in the status
panel at the bottom of the window. If you selected "None" or "Manual" in
"Transmit trigger" when configuring Dostek DNC, DDNC sends immediately, or
waits for you to click Start now.

¤ If you are using a Dostek 440A Behind-the-Tape Reader (BTR), DDNC
immediately starts sending to the 440A BTR, and the BTR stores the data in its
memory. Progress is shown in the status panel at the bottom of the window.
You don't need to wait for the transfer to finish; the CNC can start reading
from the 440A BTR immediately. 

STEP 3 - Go to the CNC, and start a Load or Run transfer.

Execute a read, load or run command on the CNC. The method varies with each
CNC model. 

For most Fanuc CNCs:

¤ To load a file into the CNC memory, select PROGRAM and EDIT modes, and
then execute a "Read" or "Input" command.

¤ To run ("drip-feed") a program directly from the computer, select TAPE mode
and then press CYCLE START. For more information about drip-feeding, see
Section 5.3, "Drip-Feeding."
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5.2 Receiving a File from the CNC

Receiving a part program file from the CNC is also easy:

1. In Dostek DNC File Manager, select a folder, and then click Receive. File Manager
opens the Communication (DDNC) window to handle the transfer.

2. Go to the CNC, and execute a "Punch" or "Output" command. The received data
scrolls in the DDNC window. 

Notes:

› Dostek DNC automatically names received files according to the program number
or description stored in the first line of the program. You can configure receive file
naming to suit your preferences. For more information and detailed examples,
open Dostek DNC Configuration (DConfig), select the "Receive Options" tab, and
then click Help in DConfig's Help menu.

› If you prefer to manually name received files, disable automatic file naming in
DConfig's "Receive Options" tab. To temporarily override automatic naming, click
Stop and then click Choose configuration in DDNC's File menu.

› Dostek DNC can receive multiple files. For example, with most Fanuc CNCs you
can type "O-9999" and then press Punch or Output to send all part program files
to the computer. Dostek DNC stores each program in a separate file. If you prefer
to store all part programs in a single file, select "Autoname-Single file" in the
"Choose CNC Configuration" window.

› To prevent CNC operators from overwriting original versions of part program files,
you can:

¤ Configure Dostek DNC to add a prefix or suffix to received file names. For
example, you can configure Dostek DNC to name program "1234" as
"!1234" or "1234#".

¤ Configure Dostek DNC to allow receiving into only one specific folder (and
its subfolders). Specify a folder in Receive folder in Dostek DNC
Configuration's "Folders" tab ("General" settings).     
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5.3 Drip-Feeding Large Files

This section explains how drip-feeding works, and how to prepare the computer, the
machine, and Dostek DNC to ensure reliable operation when drip-feeding.

Some CNC models do not allow drip-feeding. Some may require the purchase of
optional hardware or software from the CNC manufacturer, or installation of a
"Behind-the-Tape Reader "(BTR) such as the Dostek Model 440A BTR.

5.3.1 Preparing the Computer

Configure the computer as follows:

• Disable all power-saving (hibernation) and screen-saving features. Allowing the
computer to hibernate during a drip-feeding session will disrupt critical data
communication between the computer and CNC.

• Secure your computer to prevent anyone from disturbing software operation. If
the computer is disrupted, drip-feed operation will be affected. 

5.3.2 Preparing the CNC Machine

Always prepare the CNC before you start. Preparation varies with the type of CNC you
are using. In general, for example:

• Clear the CNC read buffer. Ensure that no program blocks from the previous
machining session remain in the CNC.

• Set the machine controls. For example, set the feed rate override to reduce speed
and set the machine to "SINGLE BLOCK" mode so you can carefully monitor
machine operation. Once you are confident the machine is running the program
correctly, increase the feed rate and turn SINGLE BLOCK off.

• Manually execute any necessary preparatory functions or positioning.

• Update any required tool offsets or machining parameters.

About the Read Buffer

Most CNC machine tools "read ahead" one or more program blocks from the tape
reader or serial port, and store the data in its "read buffer." When you stop the
machine before it reaches the end of the program, the buffer may contain data. To run
a different program, or restart the same program at a different position, be sure to
clear the remaining data from the reader buffer. See your CNC operator manual for
the required procedure. 

5.3.3 Configuring Dostek DNC for Drip-Feeding

To configure Dostek DNC for continuous drip-feeding:

1. Open Dostek DNC Configuration, and then select your configuration.

2. On the Transmit Options tab, choose Continuous in Repeat Mode.

3. If you are using a supplied sample configuration, skip ahead to step 6.

4. On the Port Settings tab, choose an appropriate flow control method in Flow
Control. For successful drip-feeding, flow control must work properly. In most
cases, choose "Xon/Xoff." 

5. On the Transmit Options tab, choose an appropriate trigger method in
Transmit Trigger. This setting determines how the computer knows when to
start sending data to the CNC. In most cases, choose "Xon."

6. Click Save, and then Exit, in DConfig's File menu.  
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5.3.4 How Drip-Feeding Works

When you command the CNC to start drip feeding, the CNC triggers the computer to
start sending data. The CNC stores the data received from the computer into its
"buffer."

When the CNC has read a certain amount of data, it signals the computer (using the
selected "flow control" method) to stop sending. The amount of data the CNC reads
depends on its design. Some CNCs read two or three blocks at a time, and others read
dozens or hundreds of lines at a time. 

When the CNC has executed most of the data read from the computer, it signals the
computer to start sending again.

This process repeats until the entire program is executed. 

If flow control does not work properly, Dostek DNC will send continuously without
pausing, causing the CNC (if properly designed) to report an "overflow" alarm.

5.4 Restarting a Drip-Feed Session

To start a drip-feeding session, see Section 5.1, "Sending or Drip-Feeding."

When a problem occurs while drip-feeding, you can:

• Restart from the first line in the file (Section 5.4.1).

• Restart from a specific line in the file (Section 5.4.2).

• Restart from specific text in the file, using "Find text" (Section 5.4.3).

5.4.1 Restarting from the First Line

To restart a drip-feeding session from the first line of the file:

1. Stop the machine.

2. In Dostek DNC Communication, click Stop. Dostek DNC stops sending data, and
displays "Transfer cancelled" in its status panel.

3. Click Restart. Dostek DNC prepares the file, and displays "Waiting for Trigger" in
the status panel at the bottom of its window.

4. Prepare the CNC (see Section 5.2.2, "Preparing the CNC"). Ensure the CNC read
buffer is empty.

5. Carefully start the machine. Single-step at a reduced feed rate until you are
confident the program is executing properly. View the program data on the
machine's display screen to ensure the correct program data is being fed from the
computer.  

5.4.2 Restarting from a Specific Line

To restart a drip-feeding session from a specific line within the file:

1. In Dostek DNC Communication, click Stop. Dostek DNC stops sending data, and
displays "Transfer cancelled" in its status panel.

2. Position the cursor to the line you wish to restart from. You can position the
cursor using the mouse, the scroll bar, the cursor keys and the Page Up, Page
Down, Home and End keys.   
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3. Click Start from. The restart menu appears.

4. In the restart menu, click From current line. A confirmation message appears.

1. Click Yes. The computer prepares to send the file, starting from the selected line,
and displays "Waiting for Trigger" in the status panel at the bottom of its window.

2. Prepare the CNC (see Section 5.2.2, "Preparing the CNC"). Ensure the CNC read
buffer is empty.

3. Carefully start the machine. Single-step at a reduced feed rate until you are
confident the program is executing properly. View the program data on the
machine's display screen to ensure the correct program data is being fed from the
computer.  
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5.4.3 Restarting from Specific Text (Using "Find text")

To restart a drip-feeding session from a line containing specific text within the file
using "Find text":

1. In Dostek DNC Communication, click Stop. Dostek DNC stops sending data, and
displays "Transfer cancelled" in its status panel.

2. Click Start from. The restart menu
appears.

3. In the restart menu, click Find text or
N-block number. The Find dialog opens.

4. Type the text to search for. You can type
an N-block number, comment or other
text contained within the file. For more
information about search options, see
"Using the Find Dialog," below.

5. Click Find next. Dostek DNC searches for
the text you entered. If the text is found,
it is highlighted in the Dostek DNC
window. If the text is not found between
the current position and the end of the
file, you can search again from the start of the file.

6. Examine the search result carefully. Ensure you have found the correct starting
point. The file may contain more than one instance of your search text. To find
the next instance, click Find next again.  

7. When you are certain that the correct starting position is highlighted in the
Dostek DNC window, choose one of the following actions:

a) To immediately start drip feeding from the selected (highlighted) line, click
Start here. A confirmation message appears. Click Yes.

b) To start drip feeding from a different position (for example, from a line or
two before or after the selected line):

¤ click Cancel to return to the Dostek DNC window
¤ click on the desired starting line
¤ click Start from, and then click From Current line.

8. Prepare the CNC (see Section 5.2.2, "Preparing the CNC"). Ensure the CNC read
buffer is empty.

9. Carefully start the machine. Single-step at a reduced feed rate until you are
confident the program is executing properly. View the program data on the
machine's display screen to ensure the correct program data is being fed from the
computer.
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Using the Find Dialog

The Find dialog provides two options to help you find text.

Check Line starts with to find text that begins at the start of a line.

Check Find whole word to find text that is preceded and followed by either a line
break or a space.

When searching for an N-block number:

• Type the N-block number exactly as it appears in the file. Include leading zeros.
For example, searching for "N120" does not find "N0120".

• Account for block skip characters (/). If Line starts with is checked, searching for
"N0120" does not find "/N0120".  
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6 Using "Remote" DNC Communication

With remote DNC, you can upload, download and drip-feed without leaving the CNC.
There is no need to walk to the computer. You send commands to the computer using
the CNC's control panel. 

You can also remotely print a file, view a file directory list or view recent activity
messages.

To send commands from the CNC to the computer, you simply punch out a short
program file that contains a specifically-formatted command.

Most Dostek DNC sample CNC configurations are designed to: 

• Recognize program numbers 7990 through 7998 as command programs. 

• Send messages (such as error messages or search results) as program number
7999. 

• Use single-character commands enclosed in parenthesis, such as shown in the
following table:

(M)Get messages

(P filename)Print file

(D search)Get file directory

(S filename)Save to computer

(L filename)Load from computer
Typical FormatCommand

You can easily configure Dostek DNC remote commands to suit your preference. For
more information about command formats, including detailed examples:

1. Open Dostek DNC Configuration window (DConfig).

2. Select a configuration, and then select the "Remote commands" tab.

3. Click Help in DConfig's Help menu. The "Remote commands" help topic opens.

6.1 Opening Remote Server (DRemote)

To open Dostek DNC Remote Server (DRemote):

• On the Windows All programs menu, point to Dostek DNC, and then click
Dostek DNC Remote Server.

Notes:

› Before you use remote DNC, create a separate configuration for each CNC, and
test communication using classic DNC.

› When you open DRemote for the first time, a help window opens. It explains how
DRemote works and the steps required to add each CNC. 

› To open Dostek DNC Remote Server automatically each time the computer starts,
copy the shortcut from the Windows All Programs menu to the Windows "All
Programs\Startup" folder.
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6.2 Loading a File to CNC from Computer 

To remotely load a file to the CNC from the computer: 

1. Edit a command file on the CNC to specify a file name you wish to load. For
example, to load file "A1234" from the computer, edit command program O7990: 

O7990 (DNC LOAD)
(L A1234) 

2. Send the command file from the CNC to the computer, using the CNC's punch,
send or output command. 

3. Wait 5 seconds to give the computer time to process the command. 

4. Load the file to the CNC from the computer, using the CNC's load, read or input
command. 

Notes:

› If Dostek DNC detects an error (for example, if the requested file is not found), it
sends a short error message to the CNC instead of the requested program. For
example: 

O7999 (DNC MESSAGE)
(DELETE THIS FILE AFTER READING MESSAGE)
(01 FILE NOT FOUND - F=/CNC/VMC300/O2975.TAP)
%

› You can specify a path, relative to the root folder. For example:
O7990 (DNC LOAD)
(L ACME/A1234) 

› The "(DNC LOAD)" comment in the examples is not required. It simply identifies
the purpose of the DNC command program. 

6.2.1 Controlling File Access

When you add a CNC to DRemote, you configure the "Send from" folder and "Search
subfolders" option to control where DRemote searches for requested files.

6.3 Drip Feeding a Large File 

To drip-feed a program, you use the same remote command you use for loading a file.
However, after sending the command to the computer, you execute a different
command on the CNC. 

For example, on many Fanuc CNCs you: 

• Select "Edit" mode and press "Read" or "Input" to load a program into memory. 
• Select "Tape" mode and press "Cycle Start" to drip-feed a program. 

Dostek DNC Remote Server also lets you start drip-feeding at a specific line in the
program, or automatically repeat the same program over again for multiple parts. For
example: 

• To drip feed starting at a specific block, include a search string in your command: 
O7990
(L A1234 N1000)

• To automatically repeat the same program continuously, include the "C"
(continuous) option in your command: 

O7990
(L A1234 -C)    
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6.4 Saving a File from CNC to Computer 

To remotely save a file from the CNC to the computer, simply send it from the CNC to
the computer using the CNC's punch, send or output command. Remote Server
automatically names all received files according to the part or program number. 

When you save a file from the CNC, DRemote can send a confirmation message so the
CNC operator can verify the file was saved. For more information, see Section 6.4.5,
"Confirming Saved Files."

6.4.1 Controlling File Location and Replacement

When you add a CNC to DRemote, you configure the "Receive to" folder to specify a
single folder where files received from each CNC are saved. 

Specify a different folder for each CNC to ensure two CNCs do not attempt to create a
file with the same name in the same folder at the same time.

By default, if a file with the same name as the received file already exists in the
"Receive to" folder, it will be replaced. You can prevent received files from replacing
original files in any of the following ways:

• Specify a "Receive to" folder that is separate from the folder where original files
are stored.

• Configure Dostek DNC to add a prefix or suffix to the file name. For example, add
suffix "#" to received file names so "A1234#" does not replace "A1234".

• Click Options in DRemote's Configure menu, select the "Receive" tab, and then
select "Keep (rename) existing files." DRemote will rename existing files with a
numeric suffix (plus sign followed by the date and time expressed as an 8-digit
integer) instead of replacing them. When you select this option, files are never
deleted, so a large number of files can accumulate over time. To clean up extra
versions of files:

1. Open Windows Explorer to the root folder containing received CNC
programs.

2. Search for "*+" (that is, asterisk * followed by plus sign +). A list of all files
with Dostek DNC's numeric suffix is displayed.

3. Select all found files, and press Delete.

6.4.2 Saving a File with a Specific Name 

You can override automatic file naming to remotely save a file with a specific name: 

1. Send a "Save" command file from the CNC to the computer, specifying a file
name. For example: 

O7990
(S A1234)

2. Send the data you wish to save. You can send one part program, several part
programs, or data such as tool offsets or machine parameters. 

3. After you send all of the data, send any command file from the CNC to the
computer. Dostek DNC stops receiving and closes the file when any command file
is received. For example, you can send a SAVE command, omitting the file name:

O7990
(S)       

Note:

› Be sure to close the file as indicated in step # 3. If you fail to close the file,
extraneous received data may be added to the end of the file.       
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6.4.3 Saving Multiple Programs to a Single File 

To remotely save multiple programs to a single file with a name you specify, follow the
procedure described in (previous) Section 6.4.2, "Saving a File with a Specific Name."
However, if you prefer to automatically name the file using the program name or
comment included in the first received file, use the "Save single" command instead in
step #1:

O7990
(SS)

6.4.4 Saving Machine Parameters to a File 

Dostek recommends using classic communication for saving CNC parameters to a
computer file. You can view the received parameters on the computer screen to verify
they are received correctly. However, you can also save parameters remotely using
the above "Save a File with a Specific Name" procedure.  

6.4.5 Confirming Saved Files

You can configure DRemote to automatically send a "confirmation" message to the
CNC immediately after a file is saved. This feature allows the CNC operator to verify
the file was actually saved. The confirmation message includes the file size, and the
first and last several lines from the file.

To configure DRemote to automatically send a confirmation message after receiving a
file:

1. Open the DRemote window, and select a CNC.

2. Click Disconnect in DRemote's Channel menu to disconnect the channel. The
channel must be disconnected to change its configuration.

3. Click Properties in DRemote's Channel menu. The selected CNC's properties
window opens.

4. Select Send confirmation for received files in the "Remote command options"
section, and then click OK.

5. Click Reset in DRemote's Channel menu to restart the channel.

To view the confirmation message:

• Wait 5 seconds after the CNC finishes sending the file to the computer (to allow
the computer time to process the file), and then execute a read or input
command. The confirmation message is loaded into the CNC (typically as program
O7999).

6.5 Requesting a Directory Listing

To remotely request a directory listing: 

1. Edit a command file on the CNC to specify the "Directory" command and optional
parameters. For example:

O7994
(D) or: (D filename) or: (D folder\) 

2. Send the command file from the CNC to the computer, using the CNC's punch,
send or output command. 

3. Wait 5 seconds to give the computer time to process the command. 

4. Load the response to the CNC from the computer, using the CNC's load, read or
input command.   
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6.6 Requesting Messages

To remotely request a list of recent messages: 

1. Edit a command file on the CNC to specify the "Message" command. For example:
O7994
(M)

2. Send the command file from the CNC to the computer, using the CNC's punch,
send or output command. 

3. Wait 5 seconds to give the computer time to process the command. 

4. Load the response to the CNC from the computer, using the CNC's load, read or
input command. 

6.7 Printing a File

To remotely print a file: 

1. Edit a command file on the CNC to specify the "Print" command, including the file
name. For example:

O7994
(P filename)

2. Send the command file from the CNC to the computer, using the CNC's punch,
send or output command. The file is printed on the designated printer.

 To designate a printer:

• Disconnect the channel, click Properties in DRemote's Channel menu, and type
the printer name in Print to.

6.8 Monitoring Remote DNC

You can use DRemote's user interface to test and monitor remote DNC.

To monitor remote DNC, you can:

• Click a column header in the CNC channel list to sort the list by name, COM port,
type or description. Or, point to Arrange (sort) channels by in DRemote's View
menu, and then click a sort option.

• View event log messages to monitor uploads, downloads and remote commands.

• Point to View in DRemote's Channel menu to view recent messages, the last file
sent to, or the last file received from the selected CNC.

• If you are using Ethernet/serial COM ports, and entered each port's IP address in
your CNC configurations, point to IP address in DRemote's Channel menu to test
(ping) an adapter's IP address or open the adapter's Web console.

• Point to Explore in DRemote's Channel menu to open the CNC's "Receive to" or
"Send from" folder in Windows Explorer.

• Click CNC channel report in DRemote's Configure menu to view a sorted list of
all CNC channels.   
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6.9 Testing Remote Commands

To test remote commands:

1. Test saving a file from the CNC to the computer (Section 6.9.1).

2. Test loading a file to the CNC from the computer (Section 6.9.2)

6.9.1 Testing File Save

To test file save:

1. Send a file from the CNC to the computer.

2. Observe the following messages are displayed in DRemote's message window:

Receiving: filename
Finished receiving: filename (file_size_in_bytes)

If filename is "Untitled," this means one of the following:

• The data received from the CNC does not include a file name. For example, you
output CNC parameters, tool offsets or other non-program data. You can either
manually rename the received file, or see Section 6.4.2, "Saving a File with a
Specific Name."

• The file naming settings in DConfig's "Receive Options" tab do not match the
program name or number format output by the CNC. For example, you configured
Dostek DNC to expect the program name to start with the letter "O", but it
actually starts with the colon symbol ":". This is a common problem with Fanuc
CNCs, because some models output program names as "O1234" while others
output program names as ":1234".

• Dostek DNC's communication parameters (baud rate, data, parity) do not match
the CNC communication parameters. Test communication using "classic" DNC, or
using Dostek DNC Com Test Terminal.

6.9.2 Testing File Load

To test file load:

1. Send a "Load" command program from the CNC to the computer.

2. Observe the following messages are displayed in DRemote's message window:

Receiving: filename
Finished receiving: filename (file_size_in_bytes)
Remote command: filename|command|
Sending: requested_filename (file_size_in_bytes)

If filename is "Untitled," see the previous section.

If the "No remote commands found" message is displayed, examine the command in
the "Remote command" message, and verify that it matches the command parameter
configuration you selected.

If "Remote command" and "Sending" messages are missing, Dostek DNC does not
recognize the received file as a "remote command" file. Investigate as follows:

1. Point to View in DRemote's Channel menu, and then click Last file received.
The last received file opens in the viewer window.

2. Verify that the file name matches the "Match CNC Prgrm ID" setting in the
"Remote Commands" tab for your CNC configuration.

For detailed information about testing remote commands, point to Help topics in
DRemote's Help menu, and then click Testing remote operation.    
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7 Managing Files

This section explains how you can use Dostek DNC to:

• Select files and folders
• Create, rename and delete files and folders
• Copy and move files and folders
• Find files
• View and print files
• Edit and reformat files
• Refresh the file display
• Compare files and use advanced searching

7.1 Selecting Files and Folders

To use or modify a file or folder, you must first select it:

• To select a single file, click the file.
• To select more than one consecutive file, press and hold the Shift key while

clicking files.
• To select more than one non-consecutive file, press and hold the Ctrl key while

clicking files.
• To select all files, click Select all files in the Edit menu.
• To clear file selections, click Clear selections in the Edit menu.

7.2 Creating, Renaming and Deleting Files and Folders

To rename or delete an existing file or folder, select the file and click Delete file or
Rename file in the File menu.     

To create a new file or folder:

1. In the folder window, select a folder in which to create the new file or folder.

2. In the File menu, point to Create new and then do one of the following:

¤ Click New file to create a new file.

¤ Click New folder to create a new folder.

¤ Click New duplicate file to create a duplicate copy of the currently-selected
file.

3. Type a name for the new file or folder, and then click OK. The new file or folder is
created in the file (right-hand) window.

Note:

› New duplicate file is available only when one file is selected.  
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7.3 Copying and Moving Files and Folders

Use standard Windows methods for copying and moving files and folders:

• Copy and paste

• Cut and paste (delete original file or folder after copying)

• Drag and drop

When you drag and drop files or folders, File Manager displays a menu when you
release the mouse button. This prevents you from accidentally moving files.

• Click Copy to add a copy of the items to the new location.

• Click Move to move the files from the previous location to the new location.

• Click Cancel if you change your mind.

Note:

› Dostek DNC File Manager displays a warning before replacing an existing file or
folder.   

7.4 Finding a File

To find a file in the current folder:

1. Click Go to file... in Dostek DNC File Manager's Search menu. The "Go to file"
window opens.

2. Type a file name. As you type, File Manager shows the name of the file that most
closely matches what you have typed so far. 

3. When the name of the file you are looking for appears, do one of the following:

¤ Click Send to send the file to the CNC.

¤ Click Edit to open the file in the Editor.

¤ Click View to view the file.

¤ Click Select to select the file and close the "Go to file" window.

¤ Click Cancel to close the dialog box.

Note:

› You can also open the "Go to file" using the following methods:

¤ Click the Go to file icon in File Manager's toolbar.

¤ Click File Manager's Go to file QuickButton.

¤ Press Ctrl+G.    
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7.5 Viewing Files

To view a file, select it and then click View in File Manager's File menu. While viewing
a file, you can:

• Click Print in the File menu to print the file.
• Click Edit in the File menu to open the file in the Editor.
• Click Send to CNC in the File menu to send the file directly to the CNC.
• Click Find in the Search menu to search for text.
• Press F3 to search again for the same text.
• Press F5 and F6 to quickly view the previous or next file.

7.6 Printing Files

To print a file, either the select the file in File Manager or open the file in Editor, and
then click Print in the File menu. 

To change printing options such as headers, margins, font size and page layout, click
Page setup in Dostek DNC Editor's File menu.

Editor's font preference is used for printing. To change the setting, click Preferences
in Editor's File menu.

7.7 Editing and Reformatting Part Programs

To edit a file, select it in Dostek DNC File Manager and then click Edit in the File
menu.

With Dostek DNC Editor, you can:

• Open more than one file.
• Copy and paste or cut and paste text between open files.
• Search and replace text.
• Click Save as in the File menu to save the file with a different name
• Click Block numbers in the Tools menu to sequence or resequence part program

files
• Click Convert numeric values in the Tools menu to reformat numeric values
• Click Reformat in the Tools menu to reformat part programs by any of:

¤ Adding or removing spaces between words.
¤ Converting letters to upper case.
¤ Trimming leading and trailing spaces.
¤ Filtering (removing) non-standard characters

7.8 Refreshing the File List

File Manager does not automatically refresh the display when another Windows appli-
cation creates, deletes or modifies a file in the folder File Manager is currently display-
ing. To manually update the display, click Refresh in the View menu, or click the
Refresh icon in the toolbar.   
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7.9 Comparing Files

Side-by-side file comparison lets you compare two versions of a file to find differences
or track changes.

To compare two files:

1. Open both files in Dostek DNC Editor, and then click Compare files in the File
menu. The Compare window opens. 

2. Select the files to compare from the drop-down list in both the left and right sides
of the window. If only two files are open, the files are selected automatically.

3. Click Compare. Comparison results are displayed. Each line that differs is
underlined and blue. The portion within each line that differs is red.

You can:

• Scan through the areas of difference by clicking Next difference or Previous
difference in the View menu (or by pressing Ctrl+N or Ctrl+B respectively). 

• Choose one of three comparison formats in the View menu:

¤ Split screen showing all text.

¤ Split screen showing differences only.

¤ Plain-text report showing differences only.

• Choose comparison options in the Options menu:

¤ Ignore upper/lower case, spaces, N-block numbers or blank lines.

• Search for text within the results.

• Print the report, or copy the report to an Editor window.     
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7.10 Using Advanced Searching

Advanced searching lets you search files and folders to find text.

To find files using File Manager, click Search in the Search menu. You can find files
by:

• File name. You can use Windows wild cards. For example *.TAP finds all files with
.TAP file type, or R77*.* finds all files whose name starts with R77.

• File content. For example, find all files containing a specific part number or tool
description, or all files containing a specific G-code sequence. When searching for
file content, File Manager can optionally also display the lines in the file containing
the search text.

• File date. For example, find all files modified or created within the last 30 days.

Editor and Viewer provide a "Find all" command to find all lines inside a file that
contain specific text. For example, you can view a list of all comments by searching for
"(", or you can find all lines containing a specific G code.

To use advanced searching in Editor or Viewer:

1. Click Find all in Editor's Edit menu, or click Find all in Viewer's Search menu.
The "Find All" window or prompt opens.

2. Type the text to search for and click Find or OK. The search results window
opens.

You can:

• Immediately jump to a specific line in the file by double-clicking the line in the
search results.

• Print the search results.

Tips: 

› If you include comments in your part program to identify each tool, you can use
the Editor's or Viewer's "Find all" command to prepare a tool list. For example,
include comments such as "(TOOL#11 .50 END MILL)" and then search for
"TOOL#". You can print the results, or copy them to the Windows clipboard. 

› Some users search for "(" to find and print all comments, creating a simple setup
sheet.
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8 Protecting Your Investment

To protect your investment against computer failure or loss of data, take the following
basic precautions: 

• Make multiple duplicate copies of your Dostek DNC software and license key file. 

¤ If you purchased a Dostek DNC software CD, copy the entire software CD. It
contains your software and your license key file.

¤ If you downloaded Dostek DNC, copy the downloaded file and the Dostek DNC
software license key file you received from Dostek by email.

• Make a backup copy of your Dostek DNC configuration files after initial installation
and then any time you change configuration settings.

• Make regular backup copies of your CNC data files.

• Copy your files to CDs, DVDs, other computers, a shared folder on a file server, a
"cloud" storage service, or to a USB drive. 

• Store your files where you can find them when you need them.

Note:

› To make a backup copy of your Dostek DNC configuration files, click Express
Backup in the Tools menu in Dostek DNC Configuration.

In addition to these basic precautions, consider the following additional ways to
protect your investment.

Make multiple backup copies. Two copies are better than one. Store your
backup copies in secure locations where you can find them when you need them.

Make an off-site backup copy. Store at least one copy of your data off-site. You
can:

¤ Copy your data to CDs, DVDs or a portable drive.
¤ Copy your files to Web-based storage, such as SkyDrive (Microsoft) or Google

Docs.
¤ Subscribe to an automatic off-site backup service like Carbonite Online

Backup.

Prepare a written recovery plan. Make a detailed recovery plan. Write down
how and where your data is backed up. Test your procedure, and review it at least
once a year.

Set up a backup computer. Install your software and data on a second computer
so you can quickly replace your main computer when it fails. Update the data files
and test the computer every few months.

Add Dostek DNC to your regular backup. If you have an in-house data backup
system, consider adding Dostek DNC's "Settings" folder to the backup.

Write down your CNC's communication parameters. Write them down in the
CNC's manual, or record them in the "Notes" tab in Dostek DNC Configuration or a
spreadsheet or text document.

Save your CNC parameters. Most CNC's let you output all of the parameters to a
computer. Use Dostek DNC to save the data in a disk file. Include the date in the
file name so you know when the parameters were saved. If your CNC ever loses its
parameter memory, you can load the data from the computer instead of typing it
all in by hand. Or, you can compare the current CNC parameters with a previously-
saved copy to quickly identify any differences.   
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9 Troubleshooting and Support

This section helps you with:

• Resolving installation problems (Section 9.1)
• Resolving software problems (Section 9.2)
• Resolving CNC communication problems (Section 9.3)
• Sending Configuration and Data Files to Dostek (Section 9.4)
• Getting Help (Section 9.5)

For more information about troubleshooting procedures, download the Technical
Support Procedures document from the Support page on the Dostek Web site.

9.1 Resolving Installation Problems

If you encounter a problem while installing Dostek DNC:

• Write down, print or save a screen image of every error message.

• Log on to your computer using an account with administrator privileges and
ensure all other windows are closed before you install the software.

• Carefully read and follow all messages and instructions displayed on your
computer screen during installation. 

• Fully complete the Dostek DNC First-Time Setup Wizard. It starts automatically
when the software installation is completed. 

• Try installing Dostek DNC on a different computer. There may be a problem with
your computer. Windows computers can become unstable over time due to
viruses, spyware, registry corruption, installation of non-compliant applications,
and so on.  

9.2 Resolving Software Problems

If you encounter a problem when you start Dostek DNC or perform a specific task:

• Write down, print or save a screen image of every error message.

• Write down exactly what you were attempting to do when the problem occurred,
including the commands or key sequences you pressed.

• Restart the computer and try again. Windows computers can become unstable or
low on resources.

• Ensure the computer's disk drive is not full.

• If you are attempting to access files on a network resource, ensure the network is
working properly and you have sufficient privilege.

• If you have difficulty creating, deleting or modifying files, ensure the user account
you are using has sufficient permission.
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9.3 Resolving CNC Communication Problems

Follow these instructions when troubleshooting communication problems with a CNC
that is connected directly to the computer. To troubleshoot communication problems
with the Dostek Model 440A Behind-the-Tape Reader (BTR), see Section 6.3.1 and
Section 7 in the Dostek 440A BTR User Guide.

If you encounter a problem when you upload, download or drip feed:

• Write down, print or save a screen image of every error message displayed by the
software or by the CNC.

• If the CNC displays an alarm, find the alarm description in the CNC manual and
write it down or make a copy of the manual page.

• Use the sample device configuration provided for your CNC, and carefully read the
notes provided in the "Notes" tab. For more information about using sample
configurations, see Section 4.1.1, "Using Sample CNC Configurations."

• Keep detailed notes. Before you change anything (on the computer or the CNC),
write down the current setting, the new setting, and the reason for the change.

• View the Communication Testing and Troubleshooting help file (Navigator Help
tab) for detailed recommendations for typical communication problems. Go to the
"Problem Topics" section and find the topic heading that most closely describes
your problem.

9.4 Sending Configuration and Data Files to Memex Support

To help diagnose a problem, Memex may require a copy of your Dostek DNC configu-
ration files and/or a copy of one of your CNC part programs. You can send files to
Memex by email. 

To submit your Dostek DNC configuration files by email:

1. Open Dostek DNC Configuration.

2. On the File menu, point to Explore Folder, and then click Dostek DNC
Settings. The Dostek DNC "Settings" folder opens in a Windows Explorer
window.

3. On the Explorer window's Edit menu, click Select All. All files in the Settings
folder are selected.

4. On the File menu, point to Send To, and then click Mail Recipient. A new mail
message opens.

5. Type support@memex.ca in the To box.

6. Click Send.

Note:

› If the computer does not have an email application installed, instead copy the files
to another computer that is equipped to send email. 
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9.5 Getting Help

This section explains how to get help understanding Dostek DNC software or resolving
problems. Resources include help documents, application notes, and technical support.

9.5.1 Help Documents

Dostek DNC includes more than a dozen detailed help documents to help you under-
stand, configure and use Dostek DNC, and troubleshoot CNC communication problems.
To view help documents, use any of the following methods:

• Open Dostek DNC Navigator, and then select the Help tab.

• Click Help in the Help menu of a Dostek DNC window.

• Click the Help icon in the toolbar of some Dostek DNC windows.

Help documents include a side panel with Contents and Search tabs, and a toolbar
with a Print icon.

Help topics are listed in the Contents tab. To expand or collapse sub topics, click the
[+] or [-] symbol beside the topic.

Select the Search tab to search for specific words or phrases.

Click the Print icon in the toolbar to print an entire help document, or a specific help
topic.

Note:

› To search all Dostek DNC help topics for a specific word or phrase, open Dostek
DNC Navigator (DDNav), select the Help tab, and then click the Master Help link.
The master help document combines all Dostek DNC help topics.  
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9.5.2 Application Notes

To view application notes covering a variety of topics:

• Open Dostek DNC Navigator, select the Application Notes tab, and then click
Application Note Selector.     

9.5.3 Memex Technical Support

When contacting Memex for support, provide the following information: 

• Your name, company name, telephone, and email.
• Your Dostek DNC software serial number and software version number. This

information is displayed when you click About in Dostek DNC's Help menu, and is
also recorded on the media page at the front of the optional printed User Guide. 

• If the CNC machine or Dostek DNC displays an alarm or error message, include
the exact message (write it down, or take a computer screen image or photo of
the CNC screen).

Web Site

The Memex Web site provides all the information you need to recover from a problem.
Type the following address into your Web browser, and then click Support.

memex.ca/dostek

View the Dostek Support Guide. It helps you with emergency or after-hours support
and helps you collect and submit information about a problem.

Contact Memex

E-mail: support@memex.ca
Phone: 519-742-5721
Hours: 8 am to 5 pm EST      
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Appendix A - Downloading Dostek DNC

If you purchased a new or updated version of Dostek DNC, you can download the
software from the Dostek Web site for a period of one year. Thereafter, you must
purchase a software update or support subscription to download new software
versions.

To download Dostek DNC software: 

1. Open the Dostek DNC software download page in your Web browser:
www.dostek.com/software

2. Take a moment to read the instructions and Frequently Asked Questions on the
Web page. If you are not familiar with using software downloads, click How to
download, and then read the instructions (or print the page so you can refer to
it while downloading). 

3. Click Download. The next steps depend on the options provided by the Web
browser you are using. Choose an option that saves the download file on your
computer; do not run the download without saving it. You need to keep copies of
the download so you can reinstall the software or move it to another computer
later.

4. Make multiple backup copies of the software download file. You need this file to
reinstall or repair your software. Store your backup copies where you can find
them when you need them. You can copy the download file to:

¤ a blank CD or DVD
¤ a USB drive
¤ a shared network folder
¤ other computers

5. To install the software download, open the downloaded file. The download file is
named with the prefix "DDW" followed by a five-digit software version. For
example, the file for version 15.10A is "DDW1510A.exe".     
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Appendix B - Removing Dostek DNC

Dostek may recommend removing Dostek DNC software before installing a major
Dostek DNC software update, or when repairing an installation that no longer works
properly.

Before removing Dostek DNC:

• Make a new backup copy of your Dostek DNC configuration files.

• Make a new backup copy of all other important files on your computer.

To remove Dostek DNC software:

1. Open Windows Control Panel.

2. Click Programs, Programs and features, or Add or remove programs,
depending on your Windows version and current Control Panel view. Windows
displays a list of installed software.

3. Click "Dostek DNC" in the program list to select it, and then click Uninstall.

Some Dostek DNC files or registry keys may not be removed by Uninstall. You can
optionally remove any remaining files by opening Windows Explorer and searching for
"Dostek DNC" folders or registry keys in the following locations:

• "C:\" (C-drive root folder)

• "C:\Program files" or "C:\Program files (x86)"

• "C:\ProgramData"

• Registry "HKEY_CURRENT_USER\Software\Dostek"

• Registry "HKEY_CURRENT_USER\Software\Wow6432Node\Dostek"
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Appendix C - File Locations

Dostek DNC installs or creates files in the following locations:

Dostek DNC software and resource files:

By default, Dostek DNC software and resource files are stored in the following
folders on 32-bit and 64-bit systems respectively:
   C:\Program files

    C:\Program files (x86)

Dostek DNC requires "read" access to this location. Software and resource files
should not be modified by users.

You can override the default location during software installation. However this is
not recommended.

Dostek DNC configuration and log files:

Dostek DNC configuration settings and log files are stored in the folder specified by
the Windows environment variable "ALLUSERSPROFILE." On Windows 7 and
Windows 8 computers, this folder is usually "C:\ProgramData." Dostek DNC creates
two folders:
    C:\ProgramData\Dostek DNC\Settings
    C:\ProgramData\Dostek DNC\Log

Dostek DNC requires "read" access to the Settings folder for all user accounts, and
"full" access to the Settings folder for any user account to be used for modifying
Dostek DNC configuration settings.

If you enable Dostek DNC's event logging feature, Dostek DNC requires "full"
access to the Log folder for all users.

Dostek DNC stores primary configuration settings in files, rather than in the
Windows registry, to:

¤ make the same settings available to all user accounts
¤ make it easier to back up, copy, move and restore configuration settings

You may not change the location of configuration and log files.

CNC part programs:

You can configure Dostek DNC to access one or more specific local or network
folders, or your entire computer and network. When you install Dostek DNC, the
First-Time Setup Wizard offers to create a folder named "CNC Programs" in the
folder specified by the Windows environment variable "PUBLIC." On Windows 7 and
Windows 8 computers, this folder is usually "C:\Users\Public".

You can configure folder access any time by clicking Root folders in Dostek DNC
File Manager's Configure menu, or in the "Folders" tab in Dostek DNC
Configuration.

Dostek DNC requires "read" access to the folders you specify, or "full" access for
any users authorized to create (including receive from CNC), modify or delete CNC
part program files.    
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Dostek DNC Preferences:

Dostek DNC preferences, such as window sizes and locations, are stored in the
Windows registry, in the following key:
   HKEY_CURRENT_USER\Software\Dostek

All Dostek DNC users need "full" access to this location.

Note:

› For detailed information about Dostek DNC security features and requirements,
see Appendix D - Security."
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Appendix D - Security

Earlier versions of Dostek DNC could be configured to require a password to modify
files and configurations ("Supervisor" mode). This feature is discontinued because
current Windows versions provide excellent file security controls.

You can easily configure Windows file security to allow "read only" or "full" access to
individual user accounts.

To prevent specific user accounts from modifying Dostek DNC configuration settings,
change Windows file security settings to allow only "read" access to the Dostek DNC
Settings folder (see Appendix C , "File Locations," for the location).

When Dostek DNC main windows open, they test the ability to create and modify
configuration files. If access is restricted, Dostek DNC hides the Configure menu.

When configuring security settings:

• Ensure all Dostek DNC user accounts have "read" access to the Settings folder. To
allow a user account to modify settings, configure the user account to have "full"
access.

• Ensure all Dostek DNC user accounts have "read" access to CNC part program
files. To allow a user account to create, modify or delete CNC part program files,
configure the user account to have "full" access.

• If event logging is enabled, ensure all user accounts have "full" access to the Log
folder.

• Ensure all user accounts have "read" access to the "Program files" and "Program
files (x86)" folders. 

Viewing Permissions

To view your current permissions, click Permissions in the Help menu in a Dostek
DNC main window, or click Permissions in Dostek DNC Navigator's "Introduction"
tab.    
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Notes
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